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		« Use tool palettes to save and place user-defined hatch patterns  
  Easily hide and isolate objects in AutoCAD 2011 »

				
						Attach a PDF as an underlay

		By Ellen Finkelstein
		Lots of people use the PDF format. If you have a PDF image that you want to reference as you draw, you an attach it as an underlay, starting with AutoCAD 2010. This is similar to attaching an xref.

Choose Insert tab> Reference panel> Attach (the ATTACH command). You can also use the PDFATTACH command.







In the Select Reference File dialog box, choose a PDF file and click Open.


		
			
				

				

			

		

		
			
				Top Customization Tips Every AutoCAD User Should Know

AutoCAD is meant to be customized, but customization is one of the most complex features of AutoCAD. Gain the knowledge you need to be a master at customizing AutoCAD!

			

		

		
			
				
				Check it out!
			

			

		

	  

In the Attach PDF Underlay dialog box, if the PDF contains more than one page, choose the page you want to attach.

Choose the settings you want for the insertion point, scale, and rotation. These settings are just like attaching any xref.

Attach PDF Underlay dialog box in AutoCAD


Click OK to attach the PDF underlay.

You can snap to object snaps on the border of the underlay. For example, the corners are endpoints.
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	40 comments to Attach a PDF as an underlay


	
	
		
		
		
				T K M Galappaththy
		

				
		
		May 19, 2010 at 1:03 am
        		 
		

		Ellen

It is very great tip, but I am in question how to fine tune of the word or else document of PDF to real scale factor of the AutoCAD drawing. 

Can you comment for my another question? How can we copies all files associated with a drawing in the AutoCAD 2006/2008/2009/2010? In AutoCAD 2000 we used PACK command under Express > Tools > Pack ‘n Go.

T K M Galappaththy

		


	
		
		
				Juan Gonzalez
		

				
		
		August 4, 2011 at 8:40 pm
        		 
		

		Excellent, but I have a question: How can I see the rest of the pages in a multipage PDF file when I insert it as xref?. Thank you.

		


	
		
		
				Ellen
		

				
		
		August 4, 2011 at 9:39 pm
        		 
		

		If you attach the PDF at a scale of 1, it should be OK. I created a PDF of a 3×3 square and inserted it and it was 3×3 in my drawing.

For putting together files, use ETRANSMIT.

		


	
		
		
				Ellen
		

				
		
		August 4, 2011 at 9:41 pm
        		 
		

		Just tried this. When you attach a multi-page PDF, you’re prompted to select the pages you want to insert, then prompted individually for an insertion point and scale for each page. At least, that’s what happens when I do it in AutoCAD 2012. I’d never tried this before, so thanks for that question!

		


	
		
		
				MOHD
		

				
		
		August 5, 2011 at 3:03 am
        		 
		

		AMAZING.BUT CANN I HAVE REPLY FOR MY QUESTION BELOW:

HOW I CANDOING MODIFICATIONS FOR THIS INSERTED PDF FILE,I MEAN IF I HAVE AN PDF DRAWING AND I NEED TO MODIFY OR UPDATE THIS DRAWING ON AUTOCAD SCREEN AND I JUST HAVE THIS DRAWING IN PDF FORMAT, SO I THOUGHT WHEN I WANT TO UPDATE THIS DRAWING I WILL GOING TO INSERT IT ON AUTOCAD SCREEN BECUASE WHEN INSERT THIS FILE MOSTLY I HAVE GOT LIKE A JPG. THANK YOU

		


	
		
		
				CAROL
		

				
		
		November 8, 2011 at 2:32 pm
        		 
		

		I INSERTED A PDF AND A DWG FROM MASTERCAM INTO A DWG THAT I WAS WORKING ON.. I SENT IT TO THE PERSON THAT SENT THE MASTER CAM DWG AND TO ANOTHER TO OPEN, BUT IT WILL NOT OPEN.

I REMOVED ALL THE PDF AND THE MASTER CAM DWG, IT WILL NOT OPEN WHEN SENT.

I COPIED ALL OF MY WORK TO A NEW DWG FILE.  BUT IT STILL CANNOT BE OPENED BY OTHERS.

IT SEEMS TO HAVE INFILTERATED THE WHOLE DWG.

		


	
		
		
				Ellen
		

				
		
		November 9, 2011 at 2:40 pm
        		 
		

		First, test another drawing to see if it’s really the drawing.

Then, try the WBLOCK to create a new drawing and see if people can open that.

The PDF may have some restrictions that corrupted the drawing.

		


	
		
		
				Chris
		

				
		
		November 29, 2011 at 6:22 am
        		 
		

		MOHD:

You CANNOT change it unless you draw around all the lines, so effectively you have made a copy & then scale it to the correct size.

OR

Purchase a “PDF to DXF converter” – bear in mind that this will only work on pdf’s which are not password protected.

		


	
		
		
				phil
		

				
		
		May 5, 2014 at 11:27 pm
        		 
		

		i have a dwg file of contours of a piece of land.I want to import,place,rotate,scale a pdf or jpg file that shows manipulation of contours-new design-.I have at least two common points on the dwg and pdf files.can you please help me to do this?

		


	
		
		
				J Ryder
		

				
		
		May 20, 2014 at 9:51 am
        		 
		

		Phil, Select Insert > Reference > Attach and select the PDF or JPG file you want to insert.  I usually specify to select my own insertion point rather than 0,0 and place the image near where I want to underlay it.  I then find a common point on the image and move the image using that common point as the base point and move it to the corresponding point on the drawing. If it needs to be rotated, do that before scaling unless the scale is way off.  If it is then you may need to scale it up or down to get it close to size. 

To rotate the image, start the Rotate command and use the same base point you used to move the image in place.  After you’ve selected the base point note the Reference option on the command prompt.  Type ‘R’ and then select that same base point again and then select a second reference point on the image that you can match to a point on the drawing and your image should now be correctly rotated or at least close.  Next, use the Scale command to scale the image to the drawing. This works almost exactly the way the Rotate command works in that you specify a base point and then use the Reference feature to scale it from your initial base point to a second common base point. Using the Reference feature of both commands can be a bit tricky to use at first but with some trial and error it’ll become much easier to use.  I sometimes place aerial images under drawings and often have to use the Rotate and Scale commands several times before I get the image placed just right. Hope this helps!

		


	
		
		
				John Dickson (@NkosiEcosse)
		

				
		
		June 9, 2014 at 9:26 am
        		 
		

		After inserting a pdf (something I have done previously) I tried to rotate it and it disappeared. Any thought anyone?

		


	
		
		
				Eric
		

				
		
		July 22, 2014 at 1:31 pm
        		 
		

		I attached an image to my autocad file and I want to draw vector lines on top of it using an existing vector drawing. But, the image I’m trying to trace over keeps appearing on top of the vector drawing. How can I bring the vector drawing to the front so I can see it? Thanks.

		


	
		
		
				Joe West
		

				
		
		July 23, 2014 at 2:18 pm
        		 
		

		When trying to insert a pdf file into AutoCAD 2014 I can’t see the pdf files from the Select File Dialog box.  In other words when I browse from the Select File dialog box to the folder the pdf file is in that I want to insert the pdf’s in that file are not visible and it say’s “folder is empty”.  If I minimize AutoCAD and navigate to the file where my pdf should be it’s there but it won’t show up if AutoCAD is restored. Any thoughts would be greatly appreciated.

		


	
		
		
				Frank de Brouwer
		

				
		
		August 2, 2014 at 9:23 am
        		 
		

		Eric, place the pdf on a separate layer, select it (by clicken on the perimeter) then   then  en then lock the layer. It is possible that while youre working the pdf puts itself in front again (this should not behappening with the layer locked) but in the case that, unlock the layer, with draw order again to back an lock again. Hopes this answers your question.

		


	
		
		
				Faiza
		

				
		
		November 25, 2014 at 4:07 pm
        		 
		

		Hi, I hope someone can help me on this one.

I can’t attach a pdf to autocad 2013, why? Cad just crashes.

How can I attach that pdf, it is quite important cause I am going to trace the stuff on that pdf.

Please help me =/

		


	
		
		
				imran
		

				
		
		December 10, 2014 at 1:51 am
        		 
		

		While publishing cad drawing in pdf copy, it is showing folder references in pdf copy bottom side. Can any one suggest me how to remove this. First time I am facing this problem.

		


	
		
		
				Robert Williams
		

				
		
		December 17, 2014 at 3:22 pm
        		 
		

		MOHD, there is no way to modify the actual PDF using AutoCAD. You do, however, have a few options:

1. You can draw over the PDF (line by line, circle by circle) which can become very tedious if you have a large drawing or lots of detail.

2. You can find/purchase a PDF to DXF converter. However, in my experience, this is a waste of time and money. Most converters only work on PDFs that were created with a Vector Program such as AutoCAD. If it wasn’t, then the converter won’t find lines, it will only find pixels.

3. You can use AutoCAD RASTER DESIGN. This, however, requires a very high technical ability and generally only works on PDFs that were created within AutoCAD (or another Vector Graphics program). So, if the PDF was hand drawn or possibly created with another program, RASTER won’t provide the results you’re expecting.

4. (BEST OPTION if available) Go to the originator of the PDF and see if they have a CAD version or Vector Graphics file (DWG, DXF, IGES, STEP). If you can get any of those, your conversion will be much simpler.

I hope this helps.

~Robert

		


	
		
		
				Robert Williams
		

				
		
		December 17, 2014 at 3:28 pm
        		 
		

		FAIZA,

I’ve had that happen to me. I tracked it down to the PDF creator (program). Any PDF created with Adobe PDF worked fine. (Some) others caused AutoCAD to crash. I have not tested this lately, but maybe you can.

Good Luck,

~Robert

		


	
		
		
				Robert Williams
		

				
		
		December 17, 2014 at 3:31 pm
        		 
		

		IMRAN,

Is your Plot Stamp on?

To see if your Plot Stamp is on, open and extend the PLOT window (using the arrow (>) at the bottom right. Look for “Plot stamp on” and uncheck the box next to it.

Good Luck,

~Robert

		


	
		
		
				Robert Williams
		

				
		
		December 17, 2014 at 3:39 pm
        		 
		

		Joe West,

Are you inserting the PDF using the “PDF Underlay…” command in the “Insert” menu?

If you look at the bottom of the file window, you should see “Files of Type:”. In the drop down next to that, unless it shows “All Files (*.*)” or “PDF files (*.pdf)” the folder will likely appear empty.

Try using the method above to see if that helps.

Good Luck,

~Robert

		


	
		
		
				Robert Williams
		

				
		
		December 17, 2014 at 4:08 pm
        		 
		

		ELLEN,

Even if the PDF was created using AutoCAD, attaching the PDF at 1:1 scale will likely result in incorrect dimensions, unless other steps are taken.

T K M Galappaththy,

What you should do is insert the PDF at 1:1 scale, THEN find a known measurement somewhere on the PDF.

Let’s say you know the distance of a line to be exactly 10m, but the dimension as inserted shows 1m. You have a couple options to ensure your scaled dimension is 10m.

1. You can simply scale the drawing by 10. However, this only works if you know the exact scale you need to dimension to. Or, if you don’t know the exact scale,

2. You can draw temporary lines to help you scale the drawing to the exact dimension you need. What you will need to do is draw 3 lines. Let me explain each:

> LINE A: Draw this line at one end of the distance you are measuring. It helps to be PERPENDICULAR to your original (known) line so you can later OFFSET this line to your known distance. You may have to draw a temporary line along the PDF line so as to get this perfectly perpendicular.

> LINE B: Copy LINE A to the other end of the line, as inserted (in this case 1m).

> LINE C: OFFSET LINE A to the exact distance your PDF should show (in this case 10m).

3. Select (pick) the objects you want to SCALE.

4. Use the SCALE command. Pick the insertion point of LINE A, (TYPE ‘R’ for Reference), pick the insertion point of LINE A (yes, again), then pick the insertion point of LINE B, and finally pick the insertion point of LINE C.

That should get your PDF at the exact scale you require.

I would provide pictures, but I’m not sure if I could insert them into this window.

Good Luck,

~Robert

		


	
		
		
				NIRUJAN
		

				
		
		December 18, 2014 at 5:16 am
        		 
		

		Hi,

i am using Autocad 2015 and with this i have attached scane copy of drawing and i did some alternations on that drawing , when i save that file its showing very low file size in KB, but i have attached more than 13 images , each file has 10MB capacity , and i have sent that files to my co- worker , when they oprn that file its not showing attached images ,instead of image that was show rectangular box’s only, i think this is using that image file address link only, its not attached image files permanently, so any one can help me to attache the image file permanently.

		


	
		
		
				BRIAN K
		

				
		
		December 23, 2014 at 10:59 am
        		 
		

		I have several pdf drawings that I need to underlay on a drawing.

Some of the pdf drawings are pickable in Autocadd using grips and some are not.

What do I need to change in the settings of the the unpickable drawings to make them usable?

Please let me know.

		


	
		
		
				nicholas edwards
		

				
		
		February 2, 2015 at 6:56 am
        		 
		

		typical formula for insert scale (metric) for 1:50 drawing =

25.4 / ( 1 / 50 ) = 1270

or for 1:100

25.4 / ( 1 / 100) = 2540

at least for pdf’s where the File|Properties Page Size is called out in inches

		


	
		
		
				Nelson
		

				
		
		February 3, 2015 at 11:46 pm
        		 
		

		Hai,

iam using 2010 Autocad. but every drawing i save as 2007 format.and make cd submit municipality but they can not open they using higher version , i give all format like 2000,2004 and 2010 and 2013 but they cannot open ,but my company systems and friends systems can open. what is the problem please help me.

		


	
		
		
				sunil kumar
		

				
		
		March 17, 2015 at 5:48 am
        		 
		

		Dear sir

       iam using 2007 auto cad,i want convert pdf  to auto cad drawings 1:1 scale.i already convert,but 1:1 scale not matching ,plz solve my problome

		


	
		
		
				John
		

				
		
		November 27, 2015 at 7:05 pm
        		 
		

		Fairly new to TCAD, infact any CAD.

I have set up a PDF underlay as i want to draw some duct systems over it. I saved the drawing, and sent via email to another office, all they got was the ducts i had drawn, but no underlay, so it was meaningless.  Do i have to save like an Xref, not that i ve done this before , buti seem to recall being told that the xref and drg file must be in a common folder. I am a little puzzled by scaling as well.

I did the 2D and 3D Course. Wainting to use the 3D for some boat design, but cant. Ther is a guy on youtube doing it ,which looks excellent. Sadly it’s in Dutch or something and impossible to follow. Any Clues.

Thanks John.

		


	
		
		
				Nathan
		

				
		
		December 15, 2015 at 3:30 pm
        		 
		

		Hi John, when you need to send the drawing to another office use the etransmit command, this can collect all the xref’s underlays and associated parameter files to be transmitted as a package, which makes it simple for the recipient.

		


	
		
		
				Bobby D
		

				
		
		February 8, 2016 at 11:51 am
        		 
		

		i made changes to my PDF, but when I re-insert it, the old one keeps appearing.  How to I purge out the old PDF?

		


	
		
		
				Bobby D
		

				
		
		February 8, 2016 at 11:52 am
        		 
		

		BTW – I’m using AUTOCAD 2015 on a Macbook Pro

		


	
		
		
				Priscilla S
		

				
		
		June 17, 2016 at 8:24 am
        		 
		

		When inserting images or PDFs create separate layers with different colours  for each PDFs, then you can freeze-delete them and manipulate them.

Scaling: use two points where you know a measurement.

Command : scale: select objects , enter

Then use the R( reference)

Choose your two known points, and then give your known distance.

Check other distances. When stablishing those two known points try to go for the longest distance.  From a PDFs to cad you will have distortion even with scaling, then it is great for montages and visualization, but not to relay on measurements, unless you have lots of measurements that have good precision after scaling

		


	
		
		
				Lawrence
		

				
		
		September 25, 2016 at 7:20 am
        		 
		

		How to flatten an autocad file which have pdf attachment in it, so i can reduce the file for easy sending and printing to 2nd party?

		


	
		
		
				Ted Vacketta
		

				
		
		November 17, 2016 at 12:14 pm
        		 
		

		I’ve attached a pdf file of an aerial photo into an AutoCAD drawing.  It comes in as a reverse, or negative image of the aerial.  What could cause this?  I’m able to scale and rotate with no problem, but the coloring is just like a photo negative.

		


	
		
		
				Bob Persons
		

				
		
		November 30, 2016 at 2:46 pm
        		 
		

		Response to Ted Vacketta’s 11/17/2016 question: Left-click on the edge of the PDF object containing the image to select it, then right click while hovering over the object boundary and click on Properties.  Change the “Adjust colors for background” to No.  Then you should end up with a positive image.

		


	
		
		
				Jim Day
		

				
		
		February 14, 2017 at 1:50 pm
        		 
		

		Aloha,

I have attached a pdf with no problem, however although I can see it in my model, I can’t see it when I home in on it in my layout tab…

Jim

		


	
		
		
				Jim Day
		

				
		
		February 14, 2017 at 1:56 pm
        		 
		

		PS – Autocad 2013

		


	
		
		
				Jim Day
		

				
		
		February 14, 2017 at 2:32 pm
        		 
		

		PPS – Well, I don’t know what I refreshed the sheet and all of a sudden the drawing appeared! Sorry to bother you!  :-/

		


	
		
		
				Convert Pdf To Dwg Autocad 2012 | mobilib.org
		

				
		
		October 26, 2017 at 7:21 am
        		 
		

		[…] Attach a PDF as an underlay – AutoCAD Tips Blog – Ellen Finkelstein – May 14, 2010. At least, that's what happens when I do it in AutoCAD 2012. I INSERTED A PDF AND A DWG FROM MASTERCAM INTO A DWG THAT I WAS WORKING. If you can get any of those, your conversion will be much simpler. […]

		


	
		
		
				Divya
		

				
		
		June 15, 2018 at 3:36 am
        		 
		

		Hi, how to edit imported PDF drawing in Autocad 2015, please help me

		


	
		
		
				Kevin Roberts
		

				
		
		July 15, 2019 at 12:13 pm
        		 
		

		I am switching back after using microstation for several years. If I insert a multipage pdf underlay, and select page one, it appears I cannot just copy this underlay and change it to page 2.Is this correct?
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This Month's Top 10 Most Popular Cad Tips




	
Tutorials: How to Copy Objects Between Drawings

	
Use Quick Select to select objects in your AutoCAD drawing

	
Display lost toolbars in AutoCAD

	
Move objects between model and paper space

	
Create a block in AutoCAD

	
Tutorial: Create a custom simple linetype

	
Tutorial: Create a 3D model

	
Replace one block with another

	
Moving objects in front of — or behind — other objects: DRAWORDER

	
Rename named objects–blocks, dimension styles, layers, and more
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Draw faster and easier!

Top 25 Productivity Tips Every AutoCAD® User Should Know
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